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New Features in TracePro
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New TracePro Release Numbering

➢TracePro has switched to a yearly naming scheme. TracePro 2026 

version 26.1 was the first release of TracePro in 2026.

➢Official releases of TracePro 2026 will debut approximately every 90 

days, on or around the 10th of the month, starting in February.
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New Features in TracePro 2026 26.2
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TracePro 2026 26.2

➢TracePro

➢ New Hide All option

➢ New Scheme macro commands
➢ View:hide-all-objects

➢ Analysis:set-ray-colors 
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TracePro 2026 26.2

➢TracePro

➢ Hide All – New ability to hide all objects in a TracePro model with 

one command. The Hide All command is in the View menu.
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TracePro 2026 26.2

➢TracePro

➢ New Scheme macro command - View:hide-all-objects 

➢Scheme macro command for the new Hide All feature

➢ New Scheme macro command - Analysis:set-ray-colors

➢Scheme macro command to set and control ray color options in 

TracePro 
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New Features in TracePro 2026 26.1
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TracePro 2026 26.1

➢TracePro

➢ Sequence Editor – New ability to split a doublet into singlets

➢ Sequence Editor – New ability to merge singlets into a doublet

➢RayViz

➢ New Ray Colors option
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TracePro 2026 26.1

➢TracePro

➢ Sequence Editor – New ability to split a doublet into singlets
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TracePro 2026 26.1

➢TracePro

➢ Sequence Editor – New ability to merge singlets into a doublet
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TracePro 2026 26.1

➢RayViz

➢ New Ray Colors option

➢ Flux-based ray colors, Wavelength-based ray colors, Source-based 

ray colors, and All rays one color options are now available in 

RayViz
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New Features in TracePro 2025 25.3
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TracePro 2025 25.3

➢TracePro

➢ PlanOpSim Metasurfaces

➢ Sequence Editor Updates
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TracePro 2025 25.3

➢TracePro

➢ PlanOpSim Metasurfaces

➢ TracePro Expert can now be used to simulate metasurfaces 

generated with PlanOpSim’s Meta-Component software



Proprietary ‒ Lambda Research Corporation – Do Not Distribute beyond intended participant of seminar 

TracePro 2025 25.3

➢TracePro

➢ Sequence Editor Updates
➢ The TracePro Sequence Editor can now open OSLO lens files
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New Features in TracePro 2024 24.3
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TracePro 2024 24.3

➢TracePro

➢ Sequence Editor

➢Sequential raytracing in TracePro

➢Located in the Tools menu in TracePro

➢Available in TracePro Standard and Expert editions

➢Beam Footprint, Spot Diagram, Point Spread Function, 

Wavefront



Proprietary ‒ Lambda Research Corporation – Do Not Distribute beyond intended participant of seminar 

TracePro 2024 24.3

➢TracePro

➢ Sequence Editor
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New Features in TracePro 2024 24.2
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TracePro 2024 24.2

➢TracePro

➢ New .tracepro file format

➢Additional information is now saved with the TracePro model, 

including:

➢ .omlb data

➢Property data, including default and custom properties

➢Sequence data for sequential ray tracing

➢Rays

➢ The .omlb file format is still available
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New Features in TracePro 2024 24.1
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TracePro 2024 24.1

➢TracePro

➢ New and updated Material Property catalogs
➢ Schott

➢OHARA

➢Hoya

➢Hikari (Nikon)

➢CDGM

➢ Sumita

➢ Vitron

➢Umicore

➢Nikon
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New Features in TracePro 2023 23.5
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TracePro 2023 23.5

➢TracePro
➢ Diffractive Optical Element capability

➢ Updated Stray Light Analyzer
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TracePro 2023 23.5

➢TracePro Standard and Expert
➢ TracePro can now model 3 different types of Diffractive Optical Elements

➢ Holographic Optical Elements (HOEs)

➢ Computer Generated Holograms (CGHs)

➢ Zernike Phase

➢ CGH surfaces can be:
➢ Radially symmetric

➢ Asymmetric x-y

➢ Asymmetric (absolute value)

Surface Property Editor showing HOE surface for a reflection grating
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TracePro 2023 23.5

HOE reflection grating in TracePro CGH lens example in TracePro
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TracePro 2023 23.5

➢TracePro Standard and Expert
➢ The Stray Light Analyzer has been updated with added functionality
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New Features in TracePro 2023 23.2
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TracePro 2023 23.2

➢TracePro
➢ Improved ray trace performance

➢ Increased Scheme processing stack size for complex Scheme programs

➢ New macro commands

➢ Vector3d:cross

➢ Vector3d:dot

➢ Vector3d:normalize
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New Features in TracePro 2023 23.1
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TracePro 2023 23.1

➢TracePro
➢ Added ability to save image files (jpg, bmp,wmf) to Volume Flux Viewer
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New Features in TracePro 2022 22.6
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TracePro 2022 22.6

➢New capability to save 3D Irradiance/Illuminance Map
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TracePro 2022 22.6

➢New 3D Irradiance/Illuminance Viewer in Tools menu
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TracePro 2022 22.6

➢TracePro
➢ Added mcd (millicandela) unit option to Candela Plots
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New Features in TracePro 2022 22.5



Proprietary ‒ Lambda Research Corporation – Do Not Distribute beyond intended participant of seminar 

TracePro 2022 22.5

➢TracePro
➢ New analysis tools unit options

➢ Set Defaults capability added to Ray Sorting

➢ New RepTile geometry – tetrahedron

➢ Ray Sorting added to 3D Irradiance/Illuminance Map

➢ New capability to import multi-configuration OSLO and Zemax files

➢ New ability to select one or more paths and display them in the Candela 

Plot
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TracePro 2022 22.5

TracePro – New unit options have been added to the analysis tools. Also, 

the units are now set in the appropriate Options dialog boxes.
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TracePro 2022 22.5

TracePro – Ray Sorting now has a Set Defaults option to allow users to 

save commonly used settings as the default values
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TracePro 2022 22.5

TracePro – A new RepTile geometry type, Tetrahedron, has been added
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TracePro 2022 22.5

TracePro – Ray Sorting can now be used with the 3D 

Irradiance/Illuminance Map
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TracePro 2022 22.5

TracePro – TracePro can now import multi-configuration files from OSLO 

and Zemax
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TracePro 2022 22.5

TracePro – Path Sorting can now be used with the Candela Plots in 

TracePro



Proprietary ‒ Lambda Research Corporation – Do Not Distribute beyond intended participant of seminar 

New Features in TracePro 2022 22.2
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TracePro 2022 22.2

➢TracePro
➢ Group for imported lenses

➢Light Source Builder
➢ Convert Lucidshape and Zemax rayfiles to TracePro rayfile format
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TracePro 2022 22.2

TracePro – Imported lenses are now placed in a new group in TracePro. 

The name of the lens file will be the name of the group in TracePro.
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TracePro 2022 22.2

Light Source Builder – New ability to convert LightTools, Lucidshape, and 

Zemax rayfiles to a TracePro rayfile format
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New Features in TracePro 2022 22.1
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TracePro 2022 22.1

➢TracePro
➢ New geometric modeler

➢ New surface types and aperture shapes for the Lens Element

➢ New All-mouse mode

➢ New dynamic highlighting and tooltips for identifying surfaces

➢ New file format *.OMLB

➢ STEP and IGES translators now included at no charge

➢ New CAD importers included at no charge

➢ New Environment options for Material and Bulk Scatter

➢Light Source Builder
➢ New source builder utility for making many different source types
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TracePro 2022 22.1

TracePro – New Kosmos® KCM® geometric modeler made by Kubotek3D® 

gives TracePro the capability to model asymmetric and free-form optical 

surfaces with the accuracy required for optical ray tracing.
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TracePro 2022 22.1

TracePro – CAD translators and importers included at no additional cost

 

• CAD Translators
• STEP

• IGES

• SAT

• CAD Importers
• SOLIDWORKS

• NX/Unigraphics

• Inventor

• Creo/Pro-E

• SolidEdge

• CATIA v4 and v5
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TracePro 2022 22.1

TracePro – New All-mouse mode enables users complete many view 

manipulations using only the mouse

• Left-button drag – orbit the view

• Right-button drag up and down – zoom the view

• Both-buttons – pan the view



Proprietary ‒ Lambda Research Corporation – Do Not Distribute beyond intended participant of seminar 

TracePro 2022 22.1

TracePro – Many new surface types have been added to the Lens Element  

including, Q-type aspheres, Biconics, Asymmetric Zernike, Super Conic, 

Radial Spline, and many more.
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TracePro 2022 22.1

TracePro – Lens Element Aperture and Obstruction options now include 

Circle, Rectangle, Ellipse, Rounded rectangle, and Polygon
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TracePro 2022 22.1

TracePro – Material and Bulk Scatter Properties can now be applied to the 

environment in TracePro
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TracePro 2022 22.1

TracePro – Material and Bulk Scatter Properties can now be applied to the 

environment in TracePro

BK7 lens in air

BK7 lens in seawater

BK7 lens in seawater with scatter
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TracePro 2022 22.1

TracePro – New Dynamic Highlighting. Move the cursor over an object or 

surface to dynamically highlight the object or surface and display its name
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TracePro 2022 22.1

TracePro – New TracePro file extension .OMLB. TracePro 2022 can also 

open .OML files. Older versions of TracePro will not be able to open 

.OMLB files.
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TracePro 2022 22.1

Light Source Builder – The new Light Source Builder gives uses a wizard 

tool and gives users the ability to make multiple types of light sources.
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TracePro 2022 22.1

Light Source Builder – Surface Source Property
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TracePro 2022 22.1

Light Source Builder – Surface Source Property
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TracePro 2022 22.1

Light Source Builder – Surface Source Property from IES file
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TracePro 2022 22.1

Light Source Builder – Surface Source Property from IES file
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New Light Source Builder

Surface Source Property from IES file
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New Features in TracePro 2021 21.5
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TracePro 2021 21.5

➢TracePro
➢ New Stary Light Analyzer utility

➢ Interactive Optimizer
➢ New rectangular hole option has been added to the Reflector object type

➢Lighting Toolkit
➢ New regulations have been added

➢ Regulations have been updated

➢New Scheme commands



Proprietary ‒ Lambda Research Corporation – Do Not Distribute beyond intended participant of seminar 

New Features in TracePro 2021 21.4
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TracePro 2021 21.4

➢TracePro
➢ New Stary Light Analyzer utility

➢ Interactive Optimizer
➢ New rectangular hole option has been added to the Reflector object type

➢Lighting Toolkit
➢ New regulations have been added

➢ Regulations have been updated

➢New Scheme commands
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TracePro 2021 21.4

TracePro – A new Stray Light Analyzer utility has been added to TracePro. 

This utility automates and simplifies many of the steps necessary to do a 

stray light analysis. 
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TracePro 2021 21.4

Interactive Optimizer – The Reflector object type in the Interactive 

Optimizer has been updated so that a rectangular hole can be added to the 

reflector in addition to the previous circular option.
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TracePro 2021 21.4

Lighting Toolkit – Eight new regulation tables have been added

 ➢ ECE R7 2019

➢ ECE R119 (2014)

➢ ECE R6 2008

➢ SAE J588

➢ SAE J222

➢ SAE J592

➢ SAE J594

➢ SAE J845
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TracePro 2021 21.4

Lighting Toolkit – Six regulation tables have been updated

 ➢ ECE R6

➢ ECE R3

➢ ECE R91

➢ ECE R98

➢ ECE R112 (2010, 2012)

➢ FMVSS 108 Figures 17, 27, 28
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TracePro 2021 20.3

➢New Scheme commands

➢ geometry:get-block-parameters

➢ modify:primitive-block
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New Features in TracePro 2021 21.3
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TracePro 2021 21.3

➢TracePro
➢ Exposure Compensation for Photorealistic Rendering and TrueColor plots

➢Lighting Toolkit
➢ New ECE regulations have been added to the Lighting Toolkit

➢Analysis Toolkit
➢ A polygon analysis shape for luminance analysis has been added

➢New Scheme commands
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TracePro 2021 21.3

TracePro – A new Exposure Compensation option has been added to the 

Photorealistic Rendering and TrueColor Plots. This allows normalizing the 

color to a saturated white or monochromatic color. There is also a new 

option to normalize to the highest color in the plot.
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TracePro 2021 21.3

Lighting Toolkit – Three new ECE regulation tables 

• ECE R91 side marker lamps

• ECE R119 cornering lamps

• ECE R77 parking lamps
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TracePro 2021 21.3

Analysis Toolkit – A new analysis shape, polygon, has been added to the 

Luminance Analysis tool in the Analysis Toolkit 
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TracePro 2021 21.3

Analysis Toolkit – A new analysis shape, polygon, has been added to the 

Luminance Analysis tool in the Analysis Toolkit 
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TracePro 2021 20.3

➢New Scheme commands
➢ New Scheme commands have been added

➢ geometry:make-circular-edge-3pt

➢ geometry:make-circular-edge
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New Features in TracePro 2021 21.2
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TracePro 2021 21.2

➢TracePro
➢ New source type - Image Source

➢ Updated CGDM glass catalogs
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TracePro 2021 21.2

TracePro – A new source type, the Image Source has been added. An 

image file such as a JPEG or Bitmap file can now be used as a source in 

TracePro.
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TracePro 2021 21.2

TracePro – A new source type, the Image Source has been added. An 

image file such as a JPEG or Bitmap file can now be used as a source in 

TracePro.

 

Image as viewed through a wide angle lens
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TracePro 2021 21.2

TracePro – The CDGM glass catalog as been updated to reflected the 

latest data. A new CDGM-IR catalog of IR glass has been added.
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New Features in TracePro 2021 21.1
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TracePro 2021 21.1

➢ Interactive Optimizer
➢ New capability for editing values of points in the Irradiance Profile operand

➢Lighting Toolkit
➢ New FMVSS 108 regulations have been added

➢New Scheme command
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TracePro 2021 20.1

Interactive Optimizer – The capability to edit the values of points when 

defining the Irradiance Profile operand has been added
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TracePro 2021 20.1

➢Lighting Toolkit
➢ 62 FMVSS 108 regulations have been added
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TracePro 2021 20.1

➢New Scheme command
➢ New Scheme command has been added

➢ edit:rotate-objects
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